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e
1 Download Plugins

ProgramGenie Plugins are available for download from within the ProgramGenie application.

1) Onthe ProgramGenie sidebar select the Genie icon and then
2) Selectthe Resources menu
3) The select the Plugins menu option

)+
(O Projects
f= Templates
& Artefact Types

# (=) Resources > & Plugins -

& Administration

22 Analysis Flow

4) Observe the Plugins screen is displayed

=) Plugins

Available Plugins

Plugin Name Actions

Visual Studio Code @ -
IntelliJ IDEA I%,w

Visual Studio .%,\

Genie Vision Browser Extension @

« < > »

5) Click onthe download icon for the Plugin required
6) The Plugin will be downloaded and placed in the download folder
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2 Visual Studio Code Plugin

2.1 Install & Configuration

ProgramGenie VS Code Extensionis an Al-powered assistant for Visual Studio Code,
designed to streamline and accelerate software development. With ProgramGenie,
developers and QA engineers can chat directly with an intelligent assistant to analyze code,
generate new snippets, refactor existing code, ask for explanations, and get help with tricky
bugs — all without leaving the editor.

To install the ProgramGenie Plugin for Visual Studio Code, take the following steps:

1) Open the Visual Studio application
2) Onthe sidebar click on the Extension (squares) icon

[::::>,q Q Search v 3000 - o X
@ EXTENSIONS [ CHAT + 9 & | II x
*
Q Search Exten.. v I'V-
7 INSTALLED L Build with agent mode
3_9 Debugger for Java
A lightweight Java debu... Let's get started
# Microsoft )
&

Extension Pac... ©207ms
Popular extensions for J...
B

@ Gradle for Java
Manage Gradle Projects..

# Microsoft & Ask @vscode  Create Project
> RECOMMENDED 0
~~ MCP SERVERS

:> Al responses may be inaccurate.

3) Dragan drop the downloaded Visual Studio Code plugin into the Extensions area
4) Observe that the ProgramGenie Visual Studio Code plugin has been added to the
extensions list (you may need to search for it)

®] File Edit Selecion View Go -

@ EXTENSIONS [ SRS
| ISearch Extensions in Marketplace g
~ INSTALLED 18

ProgramGenie Code Assi... © 260ms
% Al-powered coding assistant for Vis...
genie-ide ]

o

Project Manager for Java

E %__JJ Manage Java projects in Visual Stud..,
—  # Microsoft &
@ Pylance
a A performant, feature-rich languag...
pars # Microsoft &

~

C

Python
F Python language support with exte...
£ Microsoft i}
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e
5) Click on the ProgramGenie icon to open the 'Extension: ProgramGenie Code Assistant'
tab, giving a full description of the plugin's operation.

#m e,

DEALS FEATURES  CHANGELOG

ProgramGenie Code Assistant
genve-de

Al-powered coding assistant for Visual Studio Code with secure authentication and intelligent code generation

Program Genie Visual Studio Code Extension

Program Genie VS Code Extension is an Al-powered assistant for Visual Studio Code, designed to streamline and accelerate software development.
With Program Genie, developers and QA engineers can chat directly with an intelligent assistant to analyze code, generate new snippets. refactor existing
code, ask for explanations, and get help with tricky bugs — ll without leaving the editor

Key Features

* Al Chat Panel: An interactive chat panel to sk the Al assistant questions and recerve responses formatted in Markdown, including code blocks
with syntax highlighting.

 Context- Aware Code Analysis: The extension can analyze currently selected code or the entire open document to provide refevant and precise
suggestions.

* Context-Aware Code Optimization: Based on 3 text prompt and context. the Al assistant can generate new code segments and insert them
directly into the editor.

= Context Aware Code Refactoring: Improve the Guality, readability, and performance of the heip of
suggestions.

6) Go tothe ProgramGenie application, click on the Identity icon on the sidebar
7) Selectthe Resources menu
8) Click onthe Personal Access Token menu option

Add New Token x

Token Name *

MyToken

| Expiration Date *

2026-01-04 B

9) The Personal Access Tokens screen is displayed
10) Click on the Add Token (+) icon

11) The Add New Token window is displayed

12
13
14
15

Enter a Name for the token
Enter an expiration Date for the token
Press save

—_— ~— ~— ~— ~— ~—

The token is created

This is the value of your token, please keepitina X
safe place,
because you will not be able to see it again!

Copy Token
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16) Click on the Copy Token button
17) Save this token in a safe place

#oNVisual St Ceude with secure authertication a..

[r—— odote
- &3 N Show Fislease Notes
M Moo v s cxae .
Bhirucit ® et tartad with accassiiy Featrss

sk vsocde

B
’ ProgramGenic Cade Assi... s
g,

[T b i s Tode
genie-de @ "

Project Manager for ke
e? Wianage v fxcjaris in Visil Sucl
== @t pe
‘search Feature Fequests

-
@ Microsolt ©

Fant for Visusl Studio
g .

sz s

eythan
PP, eycn unguage sppat i exe_
.

~ RECOMMINDED

Categories
1 ssstant quastions e
ding code blacks with

~ M StRvRS

Moo o
ot vanous file fommats [PDF, W,

@ WE

Fragraming

Lerguge:

Maachine Lusening.

@ Con o
et up-to-gate, versicn-specic do.. suggestiors.

) Go back to the Visual Studio Code application
) Select the Help (or...) menu item
)
)

— —

8
9
20) Select the Help option

21)Then select the Show all Comands option

=ProgramGenie: Configure Base URL

ProgramGenie: Configure Base URL recently used €3
ProgramGenie: Configure ProgramGenie Settings similar commands
ProgramGenie: Open ProgramGenie Chat Ctrl + Shit + G

ProgramGenie: Show ProgramGenie Configuration

ProgramGenie: Switch ProgramGenie Environment

22) Enter 'ProgramGenie: Configure Base URL' to filter the list
23) Then click on the 'ProgramGenie: Configure Base URL' option on the list
24) Enter the Base URL for your environment

# http://yourenvironment.com

Enter the Base URL for ProgramGenie API: (Press ‘Enter’ to confirm or ‘Escape’ to cancel)

25) Select the Help (or ...) menu item
26) Select the Help option
27) Then select the Show all Comands option
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»ProgramGenie: Configure ProgramGenie Setlingﬂ |

ProgramGenie: Configure ProgramGenie Settings recently used 2

ProgramGenie: Open ProgramGenie Chat Ctrl |+ Shift + & | similar commands
ProgramGenie: Show ProgramGenie Configuration
ProgramGenie: Switch ProgramGenie Environment

ProgramGenie: Validate ProgramGenie Configuration

28) Enter 'ProgramGenie: Configure ProgramGenie settings' to filter the list
29) Then click on the 'ProgramGenie: Configure ProgramGenie settings' option on the list
30) Enter the token you generated and copied earlier & press enter

Enter your Personal Access Token (PAT) (Press 'Enter’ to confirm or ‘Escape’ to cancel)

31) Click on the ProgramGenie icon in the Visual Studio Code sidebar Code sidebar

32) The ProgramGenie Al Chat Window is displayed within the Visual Studio Code
application.

)Q File Edit Selection View Go Run --- &«

@ PROGRAMGENIE: Al CHAT
O\ Chat 12:38:39 PM ~ + W

£

- % Generate, refactor, and debug code with Al

assistance.

Check out our documentation to learn more.

®
&

@ Ask me anything....
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3 IntelliJ IDEA Plugin

3.1 Install & Configuration

ProgramGenie Intelli) IDEA Code Extensionis an Al-powered assistant for IntelliJ IDEA,
designed to streamline and accelerate software development. With ProgramGenie,
developers and QA engineers can chat directly with an intelligent assistant to analyze code,
generate new snippets, refactor existing code, ask for explanations, and get help with tricky
bugs — all without leaving the editor.

To install the ProgramGenie Plugin for Intelli) IDEA, take the following steps:

1) Open the IntelliJ application
2) Onthe top menu clicon the Settings (cog) icon
3) Select Plugins from the menu

U untitled Version control Current File
Project - © Main java & Run Anything...
~ [3untitied Projact JOK s not defined E2 Project Structure...

Ctrl+Alt+Shift+S
> [.idea ) Settings... Ctrl+Comma
> Dsre To Run code, press [ ctrL | (F5 | or click the [> icon in :I'{:> Plugins... Ctrl+Shift+X

@ gitignore ) Backup and Sync... Off

public class Main { nousages
£ untitled.imi public static void main(Stringl] args) { nousages

Theme...
» [ External Libraries «
with yo t at the highlighted t eymap...
» =*scratches and Consoles ithy he highlighted te ymap.
View Mode...
systen.out.printf("Hello and welcome!®); Customize Main Toolbar
@
for (int i = 1; i <= 5; i++) {
® set one @ breakpoint for you, but
[ ] System.out.println(*i = * + i);
® !
+
5 E
Ountitled > src > © Main 15:2 LF UTF-8 (3 4spaces of

4) The Plugins settings window is displayed
5) Click on the Settings (cog) icon and select Install Plugin from Disk option

B settings @

Plugins Marketplace  Installed €
s Update Piugins Automatically
Appearance & Behavior > Ty
React
Keymep Update 3t @  prugin h Manage Plugin Repositories.
Update 3t @]  prugin nomeg
Editor HTTP Proxy Settings
3 29 React Update B 10e
i - ‘;ﬁ' 252.27307.103 -+ 252 27397.10€ Manage Plugin Certificates.
Yecson Genod CF Install Plugin from Disk..
Build, Execution, Deployment
OpenAP! Specifications Disable All Downloaded Plugins
Languages & Frameworks &
e A y Provides SUPE  Enabie ANl Downloaded Plugins % Solids, Preact,
Tools and more
Backup and Sync
Advanced Settings u Package Checker Liydats Features

« Code completion for components and properties

Jp Sovenen S Uiaies wil Ausatide

. g ‘ * JSX-specific code inspections and quick-fixes for common issues

* In-product documentation

v Vuejs Update * Code formatting

22,2739 2522730 « JSX and TSX refactorings such as Rename, Move, and Extract
Component

« Code snippets (Live Templates)

o st Do Upsae « Enmet n J5X

The plugin is bundied in Inteli) IDEA Ultimate, WebStorm, PhpStorm,
PyCharm, RubyMine, GoLand, Rider, and CLion.

g Apache Velocity Update
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6) A standard windows selction screen is displayed, click on the ProgramGenie Intelli)
plugin that was downloaded from ProgramGenie, then press the OK button on the
settings screen.

7) Click on the settings (cog) icon and select the Plugins menu option to reopen the
plugins screen.

8) Enter'ProgramGenie'into the Intelli) plugin screen search field to find the installed
ProgramGenie plugin. (If the plugin is not found, installation has failed, reapeat the
steps and if the problem persists please contact ProgramGenie support).

W setings x

Plugins  Revert changes Muketplsce  nusted ® @
G Programdenid ProgramGenie

Search Rasults (1) SQA Consultn

Gmr-m L] Disable | 100
. 1.0.0 SQA Consulting

Ouerview  Wnav's New

» Languages & Frameworks
» Tools Al-Powered Development Assistant for IntelliJ
Backup and Sync IDEA
Advanced Settings

ProgramGenie s a comprenensive Al assistant that transforms your
aewelopment workiiow by providing intelligent code analysis, generation,
and refactoring capabilities directly within IntelliJ IDEA.

# Key Features

= Interactive Al Chat Panel - Engage with an intelligent assistant
through a dedicated tool window with full Markdown support and
syntax-nighiighted code biocks

. ysis - Analyze G entire files
with Al-powered insights tailored to your specific codebase

+ Intefigent Code Generation - Generate high-quality code snippets,
functions, and classes based on natural language dascriptions

= Al-Powared Refactoring - improve code quality, readabiliy, and

pe o
* Product & Artifact Context - Scape conversations 1o specific projects

ER -

9) Select the ProgramGenie menu option on the settings sidebar, to display the
ProgramGenie Autentication screen. This screen must be completed to allow Intelli) to
connect to ProgramGenie.

a g x
o &
+ Appearance & Bahavior

Keymap Authentication
> Editor

Pluging @
» Version Control
» Bulld, Execution, Deployment

Enter your 10-character aiphanumeric Personal Access Taken (PAT) that you received from ProgramGenie.

> Languages & Frameworks This token suthw e T o T
> Tools
Backup and Syne Persanal Access Token: | Enter ¥ s Token Here @
Advanced Sattings Mo PAT stored
d Giooiel Base URL Enter Your BaseUrl Here
URL cannot be empty

Clear

10) To get a token from ProgramGenie do the following steps.
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In a ProgramGenie environmen

11)
12) Click on Identity in the sidebar and select the Personal Access Token menu option
13) The Personal Access Tokens screen is displayed

14) Click on the Add Token (+) icon
15) The Add New Token window is displayed

Add New Token X
Token Name ©
Expiration Date *

# 2026-01-04 B

Enter a Name for the token

16)
17) Enter an expiration Date for the token
18) Press save

19)

The token is created

This is the value of your token, please keepitina X
safe place,

because you will not be able to see it again!

A seassssnes @ DO

Copy Token

20) Click on the Copy Token button
21) Save this token in a safe place

® Fle o4 Seecion View Go

o oD

Edier Playground
Open walkthraugh... Ipdate

. show Rz rores
Q Manage Maven projects, execute g.
@hiroion ® Get Started with Accessibilty Festures
sk oo

E e B

ProgramGerie Code Ami. 5t
gty DT evsomasrisna cunonnTod
== @
Project Wanager for Java
P anage sma et n Vet st
= oo

-
(0 By
B Micrasant =2

Pyt
[ I rr————

| assitant questions
cing codie blacks with

Mttt o

onvert vanous file fomats (PDF, W
@ BE o -] | I—— R
hdpree (68

10
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22
23
24
25

—_ ~— ~— ~—

Press Save

Go backto the IntelliJ application

Enter the saved token in the Personal Access Token field
Enter the Base URL of your ProgramGenie environment in the Base URL field

o

Keymap

Editor
Plugins

Tools

ProgramGenie

Version Control

Backup and Sync|
Advanced Settin;

> Appearance & Behavior

Build, Execution, Deployment
Languages & Frameworks

ProgramGenie & Revert changes

Authentication

@

a

=]

Personal Access Token: = *###axsrsx

Base URL

Save Clear

https://www.myprogramgenieeny.com/

Enter your 10-character alphanumeric Personal Access Token (PAT) that you received from ProgramGenie.
This token authenticates your requests and ensures secure communication with the ProgramGenie Al service:

Apply

26) Personal Access Token validation Successful window should be displayed, press OK to

acknowledge.

=

Enter your 10-character alphanumeric Personal Access Token (PAT) that you received from ProgramGenie.

This token authenticates your requests and ensures secure communication with the ProgramGenie Al service.

Personal Access Tol

Base URL

Success

PAT validation successful. Welcome!

27) Press the OK button on the Plugins settings screen

28) Click on the ProgramGenie icon in the right sidebar to open th

screen inside Intellil

] U} untitied Versio Current File
0O < X i — ©Manjava *
] ~ [Quntied A Project JDK is not defined Setup SDK
> [J.idea .
> Disrc To Run code, press ((CtrL] (75 or click the [> icon in the gutter.
@ gitigr public class Main { nousages ||
O untitle public static void main(String[] args) { nousages -
> hExtemal . .
> 2 conenel Press [ Ctrl | (Perdod | with your caret at the highlighted text to see
how InteliiJ IDEA suggests fixing it.
7 System.out.printf(*Hello and welcome!");
8
9 for (int i = 1; i <=5; i++) {
@ Press 5] to start debugging your code. We have set one @
breakpoint for you, but you can always add more by pressing T
® )
= ° system.out.println("i = * + i);
13 T
0] 14 ¥
5 }
Quntitled > src > © Main > ) main

ProgramGenie

Please explain whatthis code

works, and

Please explain what this code doe:

System.out.printf("Hello and welc

g O

s, how it

any important det

o@o wa n

B3 Choose your project

Ty

ention files, or ask anything

81 LF UTF-8 (h4spaces @ @

e ProgramGenie plugin

11



4 Using a Plugin

4.1 Al ChatPanel

The interactive chat panel allows the user to ask the Al assistant questions and receive
responses formatted in Markdown, including code blocks with syntax highlighting.

1) Inthe Visual Studio Code application click on the ProgramGenie icon in the left sidebar.
2) Inthe IntelliJ application click on the ProgramGenie icon in the right hand sidebar.

# % | Q Search projects.. Q, Search artifacts...

Projects Genie - Plugin
Genie - EatlT prut Eatitjpg
File
Genie - Name ... »
Restaurant Order A...
Genie - IS-H SAP ¥ Project brief
MNewProject32 » User Authenticatio...
Epic

Genie - OnDem... »
Customer Order Su...

Genie - Plugin > Epic

@ Ask me anything....

o <

Click on the @ (Visual Studio Code) or Folder Icon (Intelli)) in the ‘Ask me anything’ area

)

4) Observe a menu of all the projects in the configured menu is displayed
) Selecting one of the projects will display a sub menu showing the artefacts in that project
)

You are now able to write prompts to query the selected ProgramGenie artefact, for
example ‘describe the Eat It diagram’

PROGRAMGENIE: Al CHAT

describe the Eat It diagram + @ 2 messages.

describe the Eat It diagram

The "Eat It" diagram is 2 hand-drawn sketch of a mobile application interface for
submitting and viewing restaurant orders. It outlines two main views: "Submit
Order” and "View Order.”

* Submit Order: This view allows users to input their name, address, mobile
phone number, and email, along with their order details in a text field. It
includes "Send” and *Cancel” buttons and a "Log In" button.

* View Order: This view displays customer information (name, address, phone

number, email) and the customer's arder in a text field. It includes “Done" and
“Delete” buttons. An example order of "ONE HOT DOG" is visible.

The dia| ndicates atabase is needed and that the application is
/&b platforms. Arrows connect corresponding

esting data transfer,

intends oth mobill
fiel e

@ Genie - Plugin_% || @ Eatitjpg %

7) Theresponse is displayed in the chat area

12
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8) As a further example you could select a subtask from a project then write the prompt

“create the Python code for this subtask”

4.2 Context-Aware Code Analysis

The extension can analyse selected code or the entire open document to provide relevant

and precise suggestions.

1) Open acode projectin Visual Studio Code or IntelliJ
2) Highlight a section of code

3) Right click on the highlighted code then select the “ProgramGenie Assistant”

9  @0penAPIDefinition(servers = {@Server(url = “/", description = "Defal
1@  @springRootApplication

11 NSy Ty
12 Add Selection to Chat
13

Add File to Chat

*.Sprin

Open Inline Chat Crl+l
* @para explain
*/

13 e Generate Code >
;; ) sprd) Copy Qualified Name args);
21 ¥ Generate Getters and Setters... Alt+insert
22 Generate Java Docs.. Alt+l
Change All Occurrences Ctri+F2
Refactor... Ctrl+Shift+R
Cut Crl+Xx
Copy Ctrl+C

Paste Ctri+v

# ProgramGenie Assistant Explain Code

Optimize Code
Run Java

Review Code
Debug Java

Command Palette... Ctrl+5hift+P

4) Select the Explain Code menu option
5) The outputis displayed in the ProgramGenie Chat window

PROGRAMGENIE: Al CHAT

describe this code v + W 4 messages

your application. Spring Boot will scan this class and its package (and subpackages)
for Spring components (like controllers, services, repositories, etc).
& args : This passes the command-line arguments to the Spring Boot application.
Spring Boot can use these arguments to configure the application's behavior.**

3. Important Concepts or Patterns Used:

* Spring Boot: This code is a fundamental part of a Spring Boot application. Spring Boot
simplifies the process of building and running Java applications by providing auto-
configuration, embedded servers, and other helpful features.

* main method: The standard entry point for Java applications.
* Class and Object: The code defines a class, which is a blueprint for creating objects.

* Static Method: The main method is a static method, meaning it belongs to the class
itself rather than an instance of the class.

* Command-line arguments: The args parameter allows the application to receive input
from the command line.

4. Potential Improvements or Considerations:

@ Ask me anything....

13
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4.3 Context-Aware Code Optimization

Based on a text prompt and context, the Al assistant can generate suggestions and new
code segments.

1) Open acode projectin Visual Studio Code or IntelliJ
2) Highlight a section of code
3) Right click on the highlighted code then select the “ProgramGenie Assistant”

9 @0penAPIDefinition(servers = {@Server(url = "/", description = "DefaL

1@  @springRootApplication
11 = S e
12 Add Selection to Chat
T
13 v Add File to Chat
*. Sprin
® Open Inline Chat Ctrl+1

* @paral Explain

®
/ = Generate Code
18 public s
e Sprd Copy Qualified Name args);
20 ¥
21 Generate Getters and Setters... Alt+insert
22 Generate Java Docs.. Alt+l
Change All Occurrences Ctri+F2
Refactor... Ctrl+Shift+R
Cut Ctrl+X
Copy Ctri+C
Paste Ctrl+V
ProgramGenie Assistant Explain Code
Optimize Code
Run Java
Review Code
Debug Java

Command Palette... Ctri+Shift+P

4) Selectthe Optimize Code menu option
5) The outputis displayed in the ProgramGenie Chat window

PROGRAMGENIE: Al CHAT

Analyze and optimize the f... —+ '@ 2 messages
- * Code Example (Lazy Initialization):
java [“D

import org.springframework.context.annotation.lazy;
import org.springframework.stereotype.Component;

@Component
@Lazy
public class ResourcelIntensiveBean {
public ResourceIntensiveBean() {
System.out.println("ResourceIntensiveBean initialized"); //

}

* Suggestion 2: Logging Configuration
* Explanation: Logging can have a performance impact, especially in high-throughput
applications.

@ Ask me anything....

14
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4.4 Context-Aware Code Refactoring

rs

Improve the quality, readability, and performance of existing code with the help of Al-
powered refactoring suggestions.

1) Open acode projectin Visual Studio Code or IntelliJ

2) Highlight a section of

3) Right click on the highlighted code then select the “ProgramGenie Assistant”

code

9 @0penAPIDefinition(servers = {@Server(url = "/", description = "DefaL

@springBootApplication

e e P P

Add Selection to Chat

1=
*. Sprin
® Open Inline Chat

Add File to Chat

* @paral Explain
*f

public s

Spri

Generate Code

} Copy Qualified Name
Generate Getters and Setters...
Generate Java Docs...

Change All Occurrences

Refactor...

Cut

Copy

Paste

# ProgramGenie Assistant

Run Java

Debug Java

Command Palette...

4) Select the Review Code menu option

Ctrl+l

Alt+Insert
Alt+l
Ctri+F2
Ctrl+Shift+R

Ctrl+X
Ctrl+C

Ctrl+V

Ctri+Shift+P

args);

Explain Code
Optimize Code

Review Code

5) The outputis displayed in the ProgramGenie Chat window

PROGRAMGENIE: Al CHAT

Chat

4:34:17 PM ~ + o

# 1. Overall Assessment:

The code represents a standard Spring Boot application’s main entry point. It's relatively
simple and follows common conventions. The scope for improvement within this specific
class is limited, but we can address several points related to best practices, maintainability,
and potential future considerations.

1. Cox

A Code Quality and Best Practices (Priority: Medium)

de Review Sections:

1. Naming Cenvention:

1 message

® Issue: The class name Eliminatoraplication has atypo ("Application” is

misspelled).

* Recommendation: Rename the class to EliminateraApplication . Correct spelling is

crucial for code readability and professionalism.

* Example:

Accounts

@ A

java

sk me anything....

15
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1.1 Appendix 1 : Version History

Distribution

Name

RW

‘ Role

Author

Date

22-Oct-2025

Version

1.00

Version History

Summary of Changes

(List the reason for each version of the document)

Revision Date

Version

RW Initial version 22-Oct-2025 1.00
RW Format Changes 29-0Oct-2025 1.01
RW V3.2 InteliJ update 11-Nov-2025 1.02
NJ V3.3 Update 6-Feb-2026 1.03
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